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Personalization

Create tiles

You can create tiles that provide you with quick access to a specific area of the repository. These
types of tiles are called views.

A new view is displayed as a tile in the tile navigation on your My ELO home screen.
You can create two types of views:

* Folder view: A folder view takes you straight to a frequently used folder.
» Task view: A task view shows you tasks with criteria you selected (e. g. tasks with expired

deadlines).

Information

Like views, search favorites are displayed as tiles on your My ELO home screen. You will find
more information about search favorites in the: Save search chapter.

Create folder view
You can create views for folders in the Repository work area that you use frequently.
Method

1. In the Repository work area, select the folder you want to create a view for.

2. On the ribbon, go to the View tab and select New view.

Keyboard shortcut: ALT + N

In the New view dialog box, the name of the folder is automatically displayed in the Name
field. You can change this name if you want to use a different one.

In the Folder area, the folder that you just selected in the Repository work area is already
selected. You can select a different folder if you want to.

3. Select OK.
Result
A tile is created for the new view under the Repository group in the tile navigation.
Outlook

* You can drag and drop a tile to another position.



n ELO Java Client

You can also pin a tile to the navigation bar using the context menu (right-click). For more
information, refer to the Tile navigation chapter.

* If you have created multiple views, you have the option to group them. To learn how to
create a group in the tile navigation, refer to the chapter Create group.

* You can rename or delete a folder view. To do so, select View > Views > Manage views on
the ribbon and select the corresponding view in the dialog box.

Create task view
You can create task views with your own custom criteria, for example with a high priority.

A task view creates a tile that gives you direct access to the tasks meeting the selected criteria.

Please note

Tasks displayed in a task view based on the criteria you set are no longer visible in the Tasks
work area. You can access these tasks from the corresponding task view tile in the My ELO
work area.

Method
1. Navigate to the Tasks work area.
2. On the ribbon, go to the View tab and select New view.

Keyboard shortcut: ALT + N
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| New task view X

Name of the task view @

Name Invoices

Criteria

Define the criteria for sorting tasks in this task view. @

Type Form-based workflow -
Priority -
Status . -

Name + || contains ~ || Invoice

Workflow step

+ -
Editor 0
Owner jo)
Metadata form -
Fields ® - Link rows with @ and

[C] Show postponed workflows @

3. In the New task view dialog box, define the criteria for showing tasks in the task view.

Some fields are only enabled based on other fields. For example, Fields is enabled once you
have made a selection under Metadata form.

You can set the following criteria:

o Type: You can select the type of tasks that should be filtered for here. If no task type is
selected, all tasks are displayed.

o Priority: Use the Priority drop-down menu to specify the priority according to which you
want to filter the tasks. Only tasks with the selected priority are displayed. If no
priority is selected, all tasks are displayed.

o Status/Name/Workflow step: Use the drop-down menu and the input field to define
which criteria the status, name, or workflow step of the tasks must meet for the
corresponding tasks to be displayed.

Use the drop-down menu to select which condition applies.
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In the input field, enter the character string that the selected condition should be
applied to. To enter multiple strings, separate the entries with the pilcrow character 9.

o Editor: Select an editor of the tasks. Suggestions will appear as soon as you start to
type. The task view only contains tasks assigned to the selected editor.

o Owner: Select an owner of the tasks. Suggestions will appear as soon as you start to
type. The task view only contains tasks assigned to the selected owner. The owner is
the user who started the workflow.

o Metadata form: Use the Metadata form drop-down menu to select a metadata form if
you only want tasks with the corresponding metadata form to be displayed in the task
view.

o Fields: If you have selected a metadata form, you can use the plus sign to add fields so
that you can filter by their contents.

Select the field from the first drop-down menu. In the second drop-down menu, select
which condition applies.

In the input field, enter the character string that the selected condition should be
applied to.

If you add multiple fields, you can connect the lines with and or or.

o Show postponed workflows: If this workflows option is enabled, postponed workflows
will also be displayed within the new task view.

4. Select OK.
Result
A tile is created for the new view under the Tasks group in the tile navigation.
Outlook

* You can drag and drop a tile to another position.

* You can also pin a tile to the navigation bar using the context menu (right-click). For more
information, refer to the Tile navigation chapter.

* If you have created multiple views, you have the option to group them. To learn how to
create a group in the tile navigation, refer to the chapter Create group.

* You can rename or delete a task view. To do so, select View > Views > Manage views on the
ribbon and select the corresponding view in the dialog box. You will find more information on
the Tasks work area in the Program interface > Tasks chapter.

Edit and delete tiles

Use the Edit view function to edit the settings of a folder, task, or search view.

The Delete view function enables you to delete the selected folder view or task view.
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Alternatively, you can use the Manage views function.

These functions can be accessed via Ribbon > View > Views.
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Customize the ribbon

There are different ways that you can personalize the ribbon.
Pin/unpin functions

While many functions are directly visible on the ribbon, others are in drop-down menus. You can
unpin functions from a drop-down menu and pin them to the ribbon.

Method

Organize Document

L Start Create task
O workflow -

Invoice ]

:D Ad hocworkflow [ L
Invoil

"

=]

B Reminder

@ I ry Pin here

M Pin to favorites h  Version date
Injoice Mar 5. 2018, «

Version control enabled

1. Right-click the desired function.
The context menu opens.
2. In the context menu, click Pin here.
Result
The function now appears on the ribbon.
Outlook

To unpin a function from the ribbon, click Unpin from here in the context menu. The function is
moved to the drop-down menu of the group.

Show/hide text

Some functions are only displayed as icons on the ribbon. The name of the function is not shown.
You can have the name displayed next to the icon.

Method
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Favorites New Qutput Organi

Unpin from here
Invoi
. Unpin from favorites
Repository Inv
— Show text
> EU Orders o

J [l Invoices
1. Right-click the desired function.

The context menu opens.

2. In the context menu, click Show text.

Result

The name of the function now appears on the ribbon.

Outlook

To hide the name of a function, click Hide text in the context menu. The name of the function is no

longer shown.

Add/remove favorites

With the default settings, the Favorites tab contains several important functions that you can
access quickly. You have the following options for adding functions to the Favorites tab:

¢ |n the context menu on the ribbon
* In the configuration

In the context menu on the ribbon

You can add functions to the Favorites tab using the context menu.

Method
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Organize Document

L Start Create task
O workflow v
Invoice x rell

P g Adhocworkflow

E Reminder

@ I ry Pin here

Invoi

Pin to favorites h  Version date
Mar 5, 2018, «

Version control enabled

1. Right-click the desired function.
The context menu opens.
2. Select Pin to favorites in the context menu.
Result
The function now appears on the Favorites tab.
Outlook

To remove a function from the Favorites tab, select Unpin from favorites in the context menu. The
function is no longer displayed on the Favorites tab. You will now find the function in the
corresponding group tab.

In the configuration

In the Quick access to functions area in the configuration, you can add functions to or remove
functions from the Favorites tab, and change their location.

Information

In the Quick access to functions area, you can also add functions to the context menus of
the work areas. Select the corresponding context menu from the Setting for drop-down
menu on the right-hand side.

Method

1. On the ribbon, select User menu [your name] > Configuration > Quick access to functions.
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@ Configuration

- Display

Color scheme

Dialog boxes

—
<]
D Metadata
D Document preview
> Quick access to functions
&,/ Annotations

@~ Advanced settings

z Technical presets

Quick access to functions

Available functions and keyboard shortcuts ®

Function Keyboard shortcut
Al assistant
~@ About Ctrl+l
& Accept substitution
\r Accept workflow
= Active processes
tz Ad hoc workflow Ctrl+W
¢ Add attachment
% Add to full text database
* All fields

® Assign replication sets

X

Functions on the Favorites tab and in the context menus

Setting for @ Favorites tab -

Back
Forward
Refresh
€ Undo
Separator line
» Goto
o New folder
@ Open in read-only mode
I, Check out and edit
o Checkin

Metadata

The Quick access to functions area opens. The settings for the Favorites tab are displayed.

The Existing functions and keyboard shortcuts list contains an overview of all available
functions in ELO. The Functions on the Favorites tab and in the context menus list contains
the functions currently visible on the Favorites tab.

2. To add a function to the Favorites tab, select the function in the left-hand column and select
the arrow pointing right between the two columns.

To remove a function from the Favorites tab, select the function in the right column and

select the arrow pointing left between the two columns.

Information

You can change the order of functions on the Favorites tab with the arrow buttons to
the right of the Settings for column.

Optional: For better visual clarity, you can insert a separator line between the functions in
the menus. Select the function Separator line from the list on the left.
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@ Company presentation

#=) Schulze and

®) [6] Multipag

| Open in read-only mode Ctrl-O

B User Managg
fzd [Administraf
B [2] [Cole] Iny
&4 [Administraf
@) [4] [Adminis

[ Invoice Con

Metadata F4

ﬁ, Check out and edit Alt-O
[8 New folder
(;% Move

X Delete Ctrl-Delete

Additional references

3. Select OK.

Result

The selected functions are either displayed or removed from the Favorites tab and the context

menu.
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Customize settings

Configuration

This dialog box is where you make settings for the ELO Java Client. The dialog box consists of the
following areas:

* Display

* Color scheme

* Dialog boxes

* Metadata

* Document preview

* Quick access to functions
* Annotations

* Advanced settings

* Technical presets

Search configuration

You can search all options in the configuration.

Enter a search term in the Search configuration field. To start the search, select Start search
(magnifying glass icon) or press the ENTER key. To reset the search, select the Reset search button
(arrow icon).

You can either make the desired setting in the results list or go to the corresponding area of the
configuration by clicking on the header.
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Configuration — Display

@ Configuration

=]
O

The

Display General

Color scheme

Feedback message duration in seconds @ 12 >
Dialog boxes '

[ Always show splitbar ®
Metadata y P

Keep entries on the Clipboard after logging out
Document preview

Default language ® |@ English
Quick access to functions

Annotations Layout options
Advanced settings
Technical presets
(@® Treeonly (O Tree and table

Font

Fontsize 10 11 12 14 16 18 14 : Default

Search

View area contains the settings for the following topics:

* General

* Layout options

* Font

* Search

* Lists and tables

* Task list display options

* List of recently used entries

General

“ Cancel

Feedback message duration in seconds: For actions without displaying a confirmation window, a
notification is displayed in the top area of the program window. Use this option to set how long the
notification is shown in seconds.

Always show split bar: You can show the split bar permanently in the viewer pane for entries. If you

disable this option, the split bar is only shown if margin notes are available.

Keep entries on the Clipboard after logging out: You determine that the contents of the Clipboard
are saved when closing the program.

Default language: You can change the language of the client.
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Layout options

There are two layout options for the Repository work area:

* Tree only: The filing structure is displayed in a tree view. The entry is displayed to the right.
» Tree and table: In addition to the tree and entry, a table is displayed that shows the content
of the element selected in the tree.

Font

Font size: Define the font size for the ELO Java Client user interface here.

Information

The ELO Java Client restarts automatically when you change the font size.

Search

Storage duration of the search entries in iSearch: Choose an option for the storage duration of the
search results.

New search view for every metadata search: Select this option if you do not want to overwrite an
existing search view when starting a search. A separate search view is created for each new
search.

Search results context: Choose whether to display the Hits column or the Results text column in
the search result list. To improve search performance, select the Disable option.

Number of synonyms: Use the spin box to specify the maximum number of synonyms suggested
for a search term. To disable synonyms, select the value 0.

Maximum number of search results per page: Define in this area how many search results are
displayed per page. The higher the number of search results per page, the longer the search takes.
If the number of search results exceeds the defined number, you can access the other search
results via the arrow buttons below the table with the search results.

Number of search suggestions per field: Specify how many search suggestions are displayed in a
metadata field during the search.

e Minimum value: 50

e Maximum value: 10000

Information

If the value is too low, you may not get any suitable suggestions for some search queries.
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Start search inallareas ~ | ®

Filedby Metadata form v

A
l‘l!telf,.f'App{y with ENTER

“ Cole (2)

n

E Administrator (45)
Anderson (72)
Byte (2)
ELO Service (11)
Farrell (2)
Santini (8)

Number of index columns for the metadata in the tasks and search results tables: Search results
and tasks are shown in table form. The table columns correspond to the fields from the metadata.
In this area, you specify how many fields from the metadata you want to display.
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Search < EX10_2020_Invoice_Coni
=n
invoices Start search inallareas ~ | O =
Type Short name
Entry type v Date w Filedby Metadataform
ch e
Type Short name 3
Restore table columns
@) EX10_2020_Invoice_Contel Type |
Link
EXTEN Invoice [Lin Ht name
Short name
[ EXTEN Invoice Date t name
@] EXTEN Invoice Hits t name
. Relevance
§H Repository i, Field, Has
Filed by
@) EXTEN Invoices Version tname
[ EXTEN Invoices Metadata form t name

Lists and tables

Show version in the tree view: Select whether and what version information to show in the tree

view after the short name.

Show document date in the tree view: If you enable this option, the document date is shown in

front of the short name.

Show folder date in the tree view: If you enable this option, the folder date is shown in front of the

short name.

Show contents of priority fields in the tree view: If you enable this option, the contents of the fields
marked as priority fields in a metadata form are displayed after the short name in the tree view.

Show version information in additional columns: Select this option to show additional information
on the entries. This includes the the version comment, the version date, and the version size,

among others.

Number of priority fields in the table columns: Define the maximum number of columns with high
priority that may be displayed in tree view. A column with high priority is used to display a field of

a metadata form.

Information
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Having a large number columns will mean it takes longer to load the view.

Maximum size of thumbnails in pixels: Define the maximum size of the thumbnails in this area.
Enter the length of the longest side in pixels. The size of the thumbnails can also be changed with
the zoom function.

Task list display options

Refresh interval for the list in minutes: Specify how often you want the task list to be refreshed by
entering a value to the field Refresh interval for the list in minutes. If the tasks list is not updated
automatically, enter 0.

Show tasks due in the following humber of days: The task list in the Tasks work area contains an
overview of all due tasks. Use this option to specify in how many days a task must be due for it to
be displayed in the task list. For example, if you enter 10 days, all tasks that are due in the next 10
days will be displayed. Tasks that are only due in 20 days are not displayed.

Maximum number of tasks displayed: With this option, you specify the maximum number of tasks
that are displayed in the task list of the Tasks work area.

Information

This setting only refers to the number of displayed tasks and not to the total number of
tasks in ELO.

List of recently used entries

Maximum number of documents in the "Most recently used" list: Use this option to define the
maximum number of recently used entries that are shown. You will find the overview of recently
used entries in the My ELO work area.

Include stored documents and folders: If you enable this option, the list will also include documents
you stored in ELO and folders you created.

Save selected entries after the set period: If this option is enabled, you will also see entries that
you have selected in the viewer pane but have not executed a function on.

Use the slider to set how much time should pass before an entry you selected appears in the list. If
you view an entry for a shorter time than set, it won't appear in the list.



E ELO Java Client

Configuration - Color scheme

A configuration x
- Display Color scheme
[= Colorscheme
— EEEEEEEEENNENEN
- EEEEEEEEEENEEEN
Metadata EEEEEElEEEEEED

IS
D Document preview
»’7

Quick access to functions
Display mode ®

Annotations

&
(‘% Advanced settings

Technical presets

Default ®

You will find the following settings in the Color scheme area.

Color scheme

Choose the color scheme for the ELO Java Client program interface in this area.
You can change the display mode via the preview images. You can select from five display modes:

* Default: The display adjusts automatically according to the settings of your operating
system.

e Light

e Dark

¢ High contrast, light

¢ High contrast, dark

Information

The ELO Java Client restarts automatically when you change the color scheme or the display
mode.
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Configuration - Dialog boxes

| Configuration

=]
O

The Dialog boxes area contains the settings for the following topics:

Display General

| Colorscheme
Show documents in tree view in dialog boxes ®

Dialog boxes

Ask for confirmation when the following number of documents are opened simultaneously ®

Metadata

Always show buttons in dialog boxes in this order: ®
Document preview ® OK, cancel
Quick access to functions O Cancel, 0K

Annotations
Version comment

Advanced settings

Dialog box for entering a version comment:

Technical presets

(® Only show when filing a new version

(O Never show

Notifications

Show message when postponing a workflow

Show message if retention period was set

(O Always show, even when filing the first version

10| - |+

“ Cance[

* General

* Version comment

* Notifications

* Annotations when sending as PDF
* Inherit permissions when moving entries
* Drag-and-drop

Duplicate check

* Load new version

* Checkin

* Delete reference

* Multiple entries as link

* Print separator pages

* Delete from the Clipboard

* Delete from the search

Login dialog box

General

Show documents in tree view in dialog boxes: If this option is selected, the documents are
displayed in dialog boxes with a tree view. If the option is disabled, only the folder structure is

displ

ayed.
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Ask for confirmation when the following number of documents are opened simultaneously: When
you open or edit many documents at the same time, it can take a while for them to load in the
client. Use this option to specify how many documents you can open or edit at the same time.

Always show buttons in dialog boxes in this order: This option enables you to specify the order of
the OK and Cancel buttons in the dialog boxes.

Version comment

Dialog box for entering a version comment: When you store a new version of a document, you can
enter a comment for this version. Select an option for displaying the version dialog box.

Notifications

Show message when postponing a workflow: If you select this option, you will be notified that the
postponed workflows will be hidden in the task list.

Show message if retention period was set: If you select this option, a notification window is
displayed when closing the Metadata dialog box. The message only appears if you have entered a
retention period on the Options tab. In this case, you will be notified that you cannot delete a
document with a retention period before the deadline has expired.

Show message if metadata does not contain a personal identifier: If this option is enabled, a
message is displayed when closing the Metadata dialog box if the fields Personal identifier and
Deletion period are empty.

Show message when setting the document status to "Non-modifiable": Define whether you want to
display a message when setting the Non-modifiable document status.

Show message when deleting files in the Intray: Documents in the Intray have not been filed to
ELO yet. If you delete documents in the Intray, the documents (and metadata) are removed and
cannot be restored. Select this option to show a message when deleting Intray documents. You will
be asked to confirm the deletion process.

Show message in the "Metadata" dialog box when changing metadata forms: If you select this
option, a message is displayed when you assign the entry a different metadata form in the
Metadata dialog box. The message only appears if a field that you already edited does not exist in
the new metadata form.

Show message when removing your own read or write permissions: Specify whether to display a
message when a user wants to revoke their own read or write permissions.

Show message when overwriting existing metadata with serial filing: Specify whether to display a
message when overwriting existing metadata with serial metadata.

Show message when searching for multiple terms in different areas of iSearch: Specify whether to
display a message when you perform a search with multiple terms in multiple areas (full text,
metadata, and feed). When you perform a search with multiple terms, only results containing all
the search terms are found.
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Show restart required message when activating/deactivating a substitution: Specify whether you
want a message to be displayed when you activate or deactivate a substitution. Changes to
substitutions do not take effect until you restart the client.

Annotations when sending as PDF

In this area, you specify how annotations on a document are handled when creating and sending a
PDF file.

Please note

When you create a PDF, margin notes on the split bar are not embedded. The embedded
annotations can no longer be edited.

* Confirm via a dialog box: A dialog box opens. In this dialog box, you can choose how to
proceed with the annotations.

* Do not embed annotations: The annotations will not be embedded in the PDF.

* Embed annotations in the PDF file: The annotations will be embedded into the PDF during
conversion.

Inherit permissions when moving entries

Behavior for differing permissions when moving documents: In this area, specify what to do with
permissions when moving an entry in the repository. Choose from the following options:

» Confirm via a dialog box: A dialog box opens. In this dialog box, you can choose how to
proceed with permissions when moving entries.

* Keep previous permissions unchanged: The moved entries retain the previous permissions.

* Replace with the permissions of the target folder: The moved entries inherit the permissions
of the target folder.

* Replace permissions inherited from the previous folder, keep individual permissions: The
moved entries inherit the permissions from the target folder. Any additional permissions will
be retained.

Drag-and-drop

Behavior when dragging a file within the repository: This is where you specify the settings for
moving entries in the Repository work area using drag-and-drop.

Choose from the following options:

* Confirm via a dialog box: A dialog box opens. This is where you specify whether the entry is
moved or referenced.

* Move: The entry is moved to the new position without confirmation.

» Reference: The entry remains at its original filing location. A reference to the entry is created
at the target location with confirmation.
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Behavior when dragging a file to a document in ELO: This is where you specify the settings for
dragging an external document onto a document that already exists in ELO.

Choose from the following options:

* Confirm via a dialog box: A dialog box opens. In the dialog box, you can determine what ELO
should do in each case.

* File as a new version of the document: This creates a new version of the document.

» Attach to front: The file is attached to the front of the document you have dragged it to.

» Attach to back: The file is attached to the end of the document you have dragged it to.

* File as new document in ELO: The document is filed to ELO as a new document.

* File as a new document with the same metadata: The document is filed to ELO as a new
document. The new document is filed with the same metadata as the document that you
drag the file to.

Information

If you have selected the File as a new version of the document option, you cannot drag and
drop onto a checked-out or deleted document.

Confirm via dialog box if you want to cancel metadata entry when filing multiple documents: If this
option is enabled, a dialog box will appear if you cancel the metadata entry asking whether you
want to file the documents with the default metadata. If the option is not enabled, the action is
aborted without asking you for confirmation.

Duplicate check

Behavior when filing a duplicate: When filing documents, the client recognizes whether the
document already exists in ELO. This is where you specify how to proceed with duplicates.

Choose from the following options:

» Confirm via a dialog box: A dialog box opens. In the dialog box, you can determine what ELO
should do in each case.

» Reference: Automatically creates a reference. The entry only exists once in ELO.

* File again: The document is stored in duplicate.

Load new version

Behavior with an identical new document version: This option refers to the Load new version
function (available in: Ribbon > Document > Versions).

This determines how the program behaves when an identical document is loaded as a new
document version using the Load new version function.

Choose from the following options:

* Confirm via a dialog box: A dialog box opens. In the dialog box, you can determine what ELO
should do in each case.
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Cancel loading the new version: No new version is created.
* File as new version anyway: Creates a new version with identical content.

Check in

Behavior when checking in an unmodified document: This option refers to the Check in function
(available in: Ribbon > Document).

Choose from the following options:

» Confirm via a dialog box: A dialog box opens. In the dialog box, you can determine what ELO
should do in each case.

* Cancel editing and restore original version: A new version is not created.

* File as new version anyway: Creates a new version with identical content.

Delete reference

Behavior when deleting a reference: Use this option to specify whether you want a dialog box to
appear before deleting a reference and what ELO should do if the dialog box is deactivated.

Choose from the following options:

» Confirm via a dialog box: A dialog box opens. In the dialog box, you can determine what ELO
should do in each case.

» Delete reference only: If this option is enabled, a dialog box will not appear. Only the
reference will be deleted. The original document will not be deleted.

* Delete original and reference: If this option is enabled, a dialog box will not appear. The
reference and the original document will be deleted.

Multiple entries as link

Behavior when creating a link when multiple entries are selected: Use this setting to define the
program behavior when sending multiple entries as an ELO link.

Choose from the following options:

* Confirm via a dialog box: A dialog box opens. In the dialog box, you can determine what ELO
should do in each case.

* Create one ELO link for each entry: This option creates an ELO link for each entry sent.

* Create one ELO link for all entries: This option creates one ELO link for all entries.

Print separator pages

Behavior when printing a separator page: This is where you specify the type of separator page to
be printed.

Sometimes, separator pages are needed, e.qg. for the Join (separator pages) function. To print a
sample separator page, select New > Scan > Scan profiles > Print separator page on the ribbon.

Choose from the following options:
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Confirm via a dialog box: A dialog box opens. In the dialog box, you can determine what ELO
should do in each case.

* Print separator page with horizontal bar: This option prints separator pages with a horizontal
bar..

* Print separator page with vertical bar: This option prints separator pages with a vertical bar.

Delete from the Clipboard

Behavior when deleting from the Clipboard: When you select this option, a message appears when
you delete an entry on the Clipboard. You must select whether you want to only remove the entry
from the Clipboard or delete it in ELO as well.

Choose from the following options:

* Confirm via a dialog box: A dialog box opens. In the dialog box, you can determine what ELO
should do in each case.

* Remove from Clipboard: The entry is deleted from the Clipboard but remains in ELO.

* Delete in ELO: The entry is removed from the Clipboard AND deleted in ELO.

Delete from the search

Behavior when deleting in the search: This option enables you to specify how the program behaves
when you delete a document in the Search work area.

Choose from the following options:

* Confirm via a dialog box: A dialog box opens. In the dialog box, you can determine what ELO
should do in each case.

* Remove from search results: The entry is removed from the search results but remains in
ELO.

* Delete in ELO: The entry is removed from the search results AND deleted in ELO.

Login dialog box

Show login dialog box when closing the program: If this option is selected, the login dialog box is
displayed when closing the program.

Show dialog box for selecting functional roles during login: If a user has been assigned functional
roles (e. g. Accounting), a dialog box for enabling the roles opens when the users logs in.
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Configuration - Metadata

¢ Configuration X

- Display General

Color scheme

[J Use default keyword list for fields ®
Dialog boxes

[] Sort keyword lists alphabetically ®

Metadata
Automatically activate keyword list filter ®

Document preview

0 i 6l

Show "Metadata" dialog box on filing if a metadata form has not been assigned ®

Quick access to functions

Show metadata
&,/ Annotations

{O) Advanced settings [J Show extra text in the metadata preview

E Technical presets Default settings for metadata

Metadata form for new folders Folder -
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The Metadata area contains the settings for the following topics:

* General

* Show metadata

» Default settings for metadata

» Metadata form for different file types

General

Use default keyword list for fields: Select this option to use a default keyword list (global) for fields
without a separate keyword list.

Sort keyword lists alphabetically: Select this option to sort keyword lists alphabetically.

Automatically activate keyword list filter: When this option is enabled, the keyword list is filtered
automatically based on the characters entered when assigning metadata.

Show "Metadata" dialog box on filing if a metadata form has not been assigned: Select this option
to open the Metadata dialog box when filing a new document. The dialog box only appears if the
document has not been assigned a metadata form. If the option is disabled, the document is
automatically filed with the default metadata form for new documents. The file name is used as
the short name.
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Show metadata

Show extra text in the metadata preview: Enable this option to display the text entered on the
Extra text tab of the Metadata dialog box in the metadata preview.

Default settings for metadata

Form for new folders: Specify which metadata form to use for new folders.
Form for new documents: Specify which metadata form to use for new documents.

Form for the metadata search: Select the metadata form that is used by default for the metadata
search.

Metadata form for different file types

In this area, you can link file extensions to metadata forms. The file extension is recognized when
you file a document. The associated metadata form is set by default. When filing without
metadata, the linked metadata form is used automatically.

By default, the .js and .vbs file extensions are linked to the ELOScripts metadata form and the .em/
and .msg file extensions are linked to the E-mail metadata form.

Use default: Restores the original settings in this area.

New: Creates a new row for linking the file type and metadata form. Enter a file extension and
select a metadata form.

X (Remove mapping): Removes the corresponding line
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Configuration - Document preview

@ Configuration
- Display
[=] Colorscheme
Fa Dialog boxes
J Metadata
D Document preview
Quick access to functions

Annotations

& ¢

% Advanced settings

R Technical presets

The Document preview area contains the settings for the following topics:

e General
¢ E-mail

General

Maximum document size for the viewer pane in MB 10| - |+

Show OCR terms in the document @
Click to transfer OCR term to form ®
[] Page between documents @

[J Increment version number during PDF conversion ®

File type for preview documents:

O TIFF
@® PDF

Use internal browser preview for HTML documents @

E-mail

Use internal browser preview for e-mails &

Suppress images from the Internet within the e-mail preview ®

[ Double-click to open files in an e-mail attachment ®

* Preview configuration for different file types

* Preview plug-ins

General

Maximum document size for the viewer pane in MB: Specify the maximum number of megabytes
(MB) a document can have in the preview. If a document exceeds the defined size, a notification

will be displayed instead of the preview. The value 0 disables the preview.

Show OCR terms in the document: Select this option to highlight the words in the document
recognized by OCR. As soon as you point to a word, the word is highlighted. If the Metadata dialog

box is open, you can click a word in a document to add it to the metadata.

Click to transfer OCR term to form: Transfer words recognized by OCR to the currently open form

with a click.

Page between documents: If you enable this option, you can go straight to the next document

when you reach the start or the end of the original document in the viewer pane.

Increment version number during PDF conversion: If this option is enabled, the document version
is incremented during PDF conversion.
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File type for preview documents: This setting refers to the Create document preview function.
Specify whether to display preview documents in TIFF or PDF format.

Please note

Depending on the selected format, the correct ELO printer (ELO TIFF Printer or ELO PDF
Printer) must be installed.

Use internal browser preview for HTML documents: If this option is enabled, HTML documents are
displayed with the internal browser instead of the embedded Internet Explorer.

E-mail

Use internal browser preview for e-mails: If this option is enabled, e-mails are displayed with the
internal browser instead of the embedded Internet Explorer.

Suppress images from the Internet within the e-mail preview: If this option is selected, images in e-
mails that are downloaded from the Internet will not be displayed. However, embedded images in
e-mails will be displayed.

Double-click to open files in an e-mail attachment: In this field, you can enter the file extensions
that you want to open by double-clicking. For all other file extensions, a dialog box for saving the
e-mail attachment opens.

Information

You can enter multiple file extensions. You need to separate the entries with periods.

Certificates for decrypting e-mails: This option allows you to specify where ELO should import the
certificates for decrypting e-mails from.

* Use Windows certificate store: If you are using ELO on a Microsoft Windows system, you can
use the certificates supplied by Microsoft Windows.

* Use certificate store from specified path: If you are not using ELO on a Microsoft Windows
system, or if you do not want to use the certificates supplied by Microsoft Windows for other
reasons, you need to select this option. In addition, you must specify where you want to
store the certificates in the Path field.

Preview configuration for different file types

In this area, you specify which type of preview to use for different file extensions. If a preview class
is not defined for a file extension, the browser will be used for the preview.

Use default: Restores the original settings in this area.

New: Creates a new row for linking the file type and preview method. Enter a file extension and
select a preview method.
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Confirm: When displaying this file type, ELO will ask every time whether you want to open the file
with the default viewer.

Remove mapping (X icon): Removes the corresponding line
Choose from the following options for configuring the preview:

* ActiveX plug-in preview: This preview type now supports viewer plugins from the ELO
Windows Client.

* Apple OS X preview: Viewer for displaying files on the macOS operating system

* Image preview: Viewer for JPG, BMP, and TIFF that can be used to place annotations on
documents.

* Browser preview: Preview in the standard browser.

» Code preview: Viewer with syntax highlighting for displaying code.

* DXL preview: Viewer for documents in DXL format.

* EML e-mail preview: Viewer for IBM Notes e-mails in .eml| format.

* Windows Media Player preview: Preview for audio and video files based on JavaFX.

* MSG e-mail preview: Viewer for Microsoft Outlook e-mails in .msg format.

* Windows Media Player preview (Windows): Preview in Windows for audio and video files.

* MS Office preview (Windows): Recommended viewer for Microsoft Office documents newer
than 2003. Also suitable for Apache OpenOffice documents (ODT).

* OpenOffice preview: Viewer for Apache OpenOffice documents. Requires an installation of
Apache OpenOffice including an additional module or LibreOffice compatible with the Java
version used in the ELO Java Client.

* PDF preview: Viewer for PDF documents with which annotations are affixed to documents. As
an alternative, you can use Internet Explorer with the Acrobat Reader plug-in (the
annotations on the document are not shown).

» Text preview: Viewer for text files; allows two font types, adjustable font size, and automatic
line breaks.

* Show preview document: With this setting, preview documents created previously are shown
instead of the original documents.

» ZIP preview: Viewer for ZIP folders, shows file contents as a tree. Files can be displayed or
saved to disk from the context menu.

Preview plug-ins
In this area, you can link file extensions to preview plug-ins.

New: Creates a new row for linking the file type and preview plug-in. Enter a file extension and the
corresponding OLE object ID.

Remove mapping (X icon): Removes the corresponding line
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Configuration - Quick access to functions
@ Configuration

- Display Quick access to functions

Color scheme
Available functions and keyboard shortcuts ®

Dialog boxes -

Metadata
Function Keyboard shortcut

Document preview
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Al assistant

Quick access to functions
~e About Ctrl+l

&,/ Annotations
& Accept substitution

{O) Advanced settings
 Accept workflow

R Technical presets
= Active processes
h configuration tm Ad hoc workflow Ctrl+W
3 Add attachment
% Add to full text database

* All fields

& Assign replication sets

Functions on the Favorites tab and in the context menus
Setting for ® Favorites tab -
Back
Forward
Refresh
€5 Undo
Separator line
» Go to
o New folder
« Open in read-only mode
I, Check out and edit
o Checkin

Metadata

You will find the following settings in the Quick access to functions area.

Quick access to functions

Available functions and keyboard shortcuts: In this column, select the function that you want to
add to the Favorites tab or a context menu. To add a function, select the function and select Add

function (arrow icon pointing to the right).

Filter: Use the Filterfield to filter the Available functions and keyboard shortcuts column. The

column is updated as soon as you enter a character.

Reset filters: Deletes the current filter from the Filter field. All functions are displayed.

Functions on the Favorites tab and in the context menus: In this column you can see which
functions are already on the Favorites tab or in the selected context menu.

Settings for: Use the Settings for drop-down menu to choose whether you want to edit the

Favorites tab or one of the context menus.
The following items are available for selection:

* Favorites tab

* Entry context menu (context menu for entries in the repository)

* Tasks context menu
* Intray context menu
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Information

Functions only appear in the context menu if they are executable in the given context.

Assign keyboard shortcuts to function

You can assign keyboard shortcuts to functions in the Available functions and keyboard shortcuts
column.

Method
1. Select the function you want to assign a keyboard shortcut to.
The function is now marked as selected.

2. Enter the desired keyboard shortcut, e.g. CTRL + L.

Please note

Some keyboard shortcuts are already in use by the operating system or other
programs. This applies in particular to the function keys F1 to F12. You can assign
keyboard shortcuts to the function keys but the commands will not be executed.
Keyboard shortcuts at the operating system level are executed first.

Result

Enter the keyboard shortcut in the field to the right of the function.
Delete keyboard shortcut

Method

1. Select the function with the keyboard shortcut you want to delete.
2. Press the BACKSPACE key.

Result

The keyboard shortcut is deleted.
Reset keyboard shortcuts

You can restore all keyboard shortcuts to default values. Click the Use default button below the
Available functions and keyboard shortcuts column.

Keyboard shortcuts as PDF file

You can save an overview of the keyboard shortcuts as a PDF file. Click the PDF output button
below the Available functions and keyboard shortcuts column.
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Add function

Method
1. Use the Settings for drop-down menu to choose where you want to add a function.

2. Select the desired function in the Available functions and keyboard shortcuts column.

3. Select Add function (arrow icon pointing to the right).

Information

The Separator line function can be added as often as you like. The separator line is
used to group functions and to set them apart from one another.

Result

The function is displayed in the Functions on the Favorites tab and in the context menus column.

Change order

You can change the order of the entries on the Favorites tab and in the context menus.
1. Use the Settings for drop-down menu to choose what you want to edit.

2. Select the desired function in the Functions on the Favorites tab and in the context menus
column.

3. Select the Move up button (arrow pointing upwards) to move the selected function up.

Alternative: Select the Move down button (arrow pointing downwards) to move the selected
function down.

Remove function

1. Use the Settings for drop-down menu to choose what you want to edit.
2. Select the desired function in the Functions on the Favorites tab and in the context menus

column.
3. Select Remove function (arrow icon pointing to the left).

Information

You can also add or remove functions by double-clicking them.

Reset functions

You can also restore the default settings of the Favorites tab or the context menus. Click Use
default below the Functions on the Favorites tab and in the context menus column.
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Configuration - Annotations

a Configuration X
- Display Sticky notes
E Color scheme
— D Sticky note yellow 3, Font B4 Color... [ Permissions
@ Dialogboxes
- Sticky note green 3, Font B4 Color... &3 Permissions
D Metadata
D Sticky note red 3, Font 4 Color... &3 Permissions
D Document preview
' Sticky note blue 3, Font K4 Color... @5 Permissions
i uick access to functions
7 Q D’ y note orange ‘ 3, Font B4 Color... &3 Permissions
[, Annotations

Marker width

&

Advanced settings

Z Technical presets Thick marker 90| -|+| Medium marker 30| -|+| Thinmarker 10 - |+

Search configuration i
N Horizontal marker

% Horizontal marker yellow B4 Color... &3 Permissions
‘ Horizontal marker green 4 Color... || & Permissions
% Horizontal marker red 4 Color... || & Permissions

The Annotations area contains the settings for the following topics:

 Sticky notes

Marker width
Horizontal marker

* Freehand marker
Rectangle marker
Strikethrough

* Redaction

« Text note configuration

Sticky notes

A sticky note is a colored text field that you can place directly on a document to record
information. There are five different colors available for sticky notes. The default colors are yellow,
green, red, blue, and orange. You can define these colors individually.

You can make the following settings:

Font: Opens the Font dialog box. You can set the font, font size, font style, font color, and
permissions for each type of sticky note here.

Color: Opens the Color selection dialog box. Use the dialog box to change the color of the
respective sticky note.
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Permissions: Opens the Permissions dialog box. Use the dialog box to define the permission
settings for the respective sticky note type.

Marker width

The Horizontal marker, Freehand marker, and Strikethrough tools are available in three different
sizes (widths). You can define the widths of the markers with the Large marker, Medium marker,
and Small marker fields.

Information

The values are about the same as the point size, depending on the font. For example, if you
enter the value 12, this corresponds approximately to the width of a line in 12-point Arial
font.

Horizontal marker

You can define five types for the Horizontal marker tool. You can define the colors and permissions
for each type.

Color: Opens the Color selection dialog box. Change the color of the respective marker in the
dialog box.

Permissions: Opens the Permissions dialog box. Define the permission settings for the respective
marker in the dialog box.

Freehand marker

You can define five types for the Freehand marker tool. You can define the colors and permissions
for each type.

Color: Opens the Color selection dialog box. Change the color of the respective marker in the
dialog box.

Permissions: Opens the Permissions dialog box. Define the permission settings for the respective
marker in the dialog box.

Rectangle marker

You can define five types for the Rectangle marker tool. You can define the colors and permissions
for each type.

Color: Opens the Color selection dialog box. Change the color of the respective marker in the
dialog box.

Permissions: Opens the Permissions dialog box. Define the permission settings for the respective
marker in the dialog box.
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Strikethrough

You can change the settings of the Strikethrough tool.

Color: Opens the Color selection dialog box. Change the background color of the Strikethrough tool
in the dialog box.

Permissions: Opens the Permissions dialog box. Define the permissions settings for the
Strikethrough tool in the dialog box.

Redaction configuration

The Redaction tool can be used to render texts unreadable.

Information

For the Redaction function to be available, some settings must be made in the ELO
database. You can find more detailed information in the documentation ELO Redaction.

Permissions: Opens the Permissions dialog box. Define the permission settings for redacting
documents in the dialog box.

Text note configuration

You can define five types for the Text note tool. You can set the font, font size, font style, font color,
and permissions for each type.

Font: Opens the Font dialog box. You can set the font, font size, font style, font color, and
permissions for each type of text note here.

Permissions: Opens the Permissions dialog box. Define the permission settings for each type of text
note in the dialog box.


https://docs.elo.com/ops/onprem/25-lts/en-us/repository/document-redaction/
https://docs.elo.com/ops/onprem/25-lts/en-us/repository/document-redaction/
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Configuration - Advanced settings

| Configuration X

- Display General
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Document preview
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Settings for the Intray work area
z Technical presets

Refresh interval for the Intray in minutes ® 0| - |+

[] Refresh Intray when opened @

Start OCR (text recognition) in the Intray ®

Show preview of the scanned pages during the scan process

[J Automatically file documents assigned a metadata form with existing filing definitions ®

[] Automatically convert TIFF files to PDF when filingto ELO ®

The Advanced settings area contains the settings for the following topics:

* General

* Settings for the Intray work area
» Separator page recognition

* Intray folder in the file system

* Workflow

* My ELO

* Signature

* Behavior on double-click

General

Drag and drop onto the top level of a view: If this setting is selected, the entry is inserted at the
top repository level when dragging and dropping onto a tile view. If this option is disabled, the
entry is inserted at the location currently selected in the view.

Information

If a document is dragged to a view that only contains a branch of the repository, the
document is filed at the top level of this view.

Always use short name as file name outside of ELO: Select this option to always use the short
name of an entry as the file name. The file name is then used when sending a document by e-
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mail, for example. If this option is enabled, the File name field is ignored on the Options tab of the
metadata form.

Optimize collaboration with ELO Desktop: This option should only be selected if the ELO Java Client
is used together with ELO DMS Desktop. Select this option to avoid slow load times when opening
Microsoft Office documents.

Transfer checked-out documents to the server when logging out: If you log into another
workstation, you have access to documents you have checked out there as well.

Checking out a folder: Check out and lock references: This option is for checking out folders. If
there are references in a checked-out folder, these are also stored in the checkout directory. To lock
the references and original files when checking out folders, select the option Checking out a folder:
Check out and lock references.

Please note

If you check out a folder with all the references, you cannot check in the references
separately. Instead, you need to check in the entire folder. In addition, you cannot check in
the original documents that are linked to the references until you have checked in the entire
folder.

Automatically compress e-mail attachments into a ZIP folder: Enter a maximum value here. If the
number of e-mail attachments exceeds this limit, the e-mail attachments will be automatically
compressed into a ZIP folder.

Settings for the Intray work area

Refresh interval for the Intray in minutes: Enter a number greater than 0 in the Refresh interval
for the Intray in minutes field if you want the Intray work area to automatically refresh at
regular intervals. The value 6 means that the Intray will not automatically refresh.

Refresh Intray when opened: Select this option to automatically refresh the Intray work area every
time you open it. This also updates the monitored folders.

Start OCR (text recognition) in the Intray: Select this option to start text recognition as soon as a
document is filed to the Intray work area. The text content of the document is available when
entering metadata, for example.

Show preview of the scanned pages during the scan process: Select this option to display the
preview of the scanned pages during the scan process.

Automatically file documents assigned a metadata form with existing filing definitions: Select this
option to automatically file documents if you have entered all metadata and the documents have a
valid filing definition. The documents are filed as soon as you close the Metadata dialog box by
selecting OK or Apply and next. You do not need to run the Automatic filing function.

Information
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You cannot create or edit metadata forms in the ELO Java Client. Contact your system
administrator if you have any questions about automatic filing and the filing definition.

Automatically convert TIFF files to PDF when filing to ELO: TIFF files are automatically converted
into PDF files when filed to ELO.

Create searchable PDFs: If this option is enabled, TIFF files are sent to OCR during automatic
conversion to create searchable PDF files.

Save Intray on server when logging out: Select this option to save checked out documents to the
Intray work area after the user logs out. If the user logs into another workstation, they have access
to their Intray documents.

Separator page recognition

Join pages: Specify which type of separator pages to use for the Join (separator pages) function.
The following options are available:

* Separator page

* Blank page

* Delete separator page and blank pages
* Triangle to mark the first page

Margin in percent: Enter a percentage of the margin of a separator page to be ignored during
recognition.

Threshold for white area in percent: Enter a threshold for the white area of a separator page to be
ignored. This makes it easier to recognize noisy separator pages.

Threshold for split bar in percent: Enter a threshold for the split bar of a separator page to be
ignored. This makes it easier to recognize noisy separator pages.

Intray folder in the file system

Include child directories when moving to the Intray: Enable this option to include all child
directories of the specified Intray directories when refreshing the Intray work area.

New: Select this button to select a folder in the file system to use as the Intray folder.

Information

You can use the variables %SUSERTEMP% and %APPDATAS% in the Intray folder.

Directory: This field shows the path to the designated Intray folder.

X (Remove directory): Removes the corresponding link to a folder in the file system.
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Workflow

Default duration of a workflow postponement in days: You can postpone a workflow for later
editing. Use this option to define the default settings in days for the Postpone workflow dialog box.

Start workflow in edit mode: Select this option to edit the selected workflow template when
starting a new workflow. If this option is not checked, you only see a list of templates. In this case,
you can open the workflow templates using the Show template button.

Show successor node users when forwarding workflows: The name of the successor node will be
displayed in the Forward workflow dialog box in addition to the name of the responsible user/

group.

Automatically refresh the "Workflow overview": This options allows you to specify whether the list
of workflows in the Workflow overview dialog box is refreshed automatically.

Display time in workflow nodes: Use this option to display the time that the workflow node was last
edited.

Default name for new workflows: In this area, you specify the default settings for the name of new
workflows. You can change the name when you start the workflow.

Choose from the following options:

* Name of workflow template

* Short name of entry

* Name of workflow template + short name of entry
* Short name of entry + name of workflow template

Process tasks with "Forward workflow" dialog box: If this option is enabled, you have to use the
Forward workflow function to process and forward the workflow in a new dialog box. If the option is
disabled, workflows without a form template are shown in the Tasks work area in a standard form
and can be processed there.

My ELO

This is where you define the settings for automatically subscribing to a feed.
Choose from the following options:

* When filing a document

* When creating a new folder

* When checking in a new version

* When creating a post or comment

Signature

Recognize signature files: In the File extensions field, specify which file extensions to recognize as
signature files.
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Information

You can enter multiple file extensions. You need to separate the entries with periods.

Save signature files: Select this option to save signature files in ELO.

Include signature file when sending documents: Select this option to send the associated signature
file along with a document.

Automatically save the signature verification log as an attachment: Select this option to store the
verification logs of the documents as an attachment.

Check signature on display: Select this option to run the signature check while displaying a signed
document.

Behavior for signing PDF documents: In this area, you specify what to do when signing PDF
documents.

Choose from the following options:

* Confirm via dialog box
* Embed signature into document
* Create separate signature file

Behavior on double-click

In this area, you can define which action is performed when double-clicking a document in the
Repository, In use, and Search work areas.
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Configuration - Technical presets

4 Configuration
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Server port | 0

[J Create a link to the entry in the ELO Web Client when sending an ELO link

Web Client URL =z B. http://REPOSITORYSERVER:9090/web-elo100,

The Technical presets area contains the settings for the following topics:

* General

* Display and refresh

Log file

Date formats

* Number formats

Show or hide work areas
Folder for document templates
* OCR (text recognition)

General

Allow participation in product improvement: Select this option to participate in ELO product
improvement.

Print via ELOprintTool (Windows): Enable this option to print documents with the ELOprintTool.

Use as scan method: Select which scan method to use.

Please note

The ELOscanTool can only be used under Microsoft Windows and requires a 32-bit TWAIN
driver.
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Set as fax printer: To send a document as a fax, the document must be sent to a fax printer that
processes the digital data and sends it to the recipient. Use this setting to specify which fax printer
to use.

Barcode serial number: Enter a valid barcode serial number here if you want to use the barcode
function at your workstation.

Information

This setting is only available to administrators.

Please note

Barcode serial numbers are unique to each workstation and may not be used multiple
times.

Script event when using a handheld barcode scanner: If this option is enabled, the ELO Java Client
sends a corresponding script event as soon as a handheld barcode scanner is recognized.

Activate script debugger for Eclipse: Select the Activate script debugger for Eclipse option to
activate the script debugger for internal scripts. This will disable the internal script debugger
(CTRL+ALT+D).

Compile and save scripts: Scripts are compiled once and then saved locally. This reduces the client
execution time. If this option is enabled, you cannot use the JavaScript debugger.

Always cache script files: If this option is enabled, scripts are always stored in the local cache even
if the document cache is cleared when you close the program. This reduces the client execution
time.

Enable HTTP Automation Interface: Selecting the Enable HTTP Automation Interface option allows
you to call scripting functions starting with the prefix http via the HTTP Automation Interface. To do
so, you need to enter the corresponding port number in the Server port field.

The syntax must have the following format:
http://<server>:<port>/script/<script name>/?pl=<parameter valuel>&p2=<parameter value2>
Server port: To call script functions via the HTTP Automation Interface, you need to enter the

corresponding port number in the Port field.

Create a link to the entry in the ELO Web Client when sending an ELO link: If this option is enabled,
a web link to the entry is embedded in the e-mail when sending an ELO link. This web link can also
be used as an ELO link in the ELO Web Client.

Web Client URL: For the additional web link when sending an ELO link to work, you need to enter
the ELO Web Client URL to the Web Client URL field.
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Store cookies in integrated browser: If this option is enabled, ELO stored the internal browser
cookies across sessions. Otherwise, the cookies are deleted when the client is closed.

Add references to full text database: If this option is enabled, references are included when adding
to the full text database.

Autosave option for changed settings in minutes: This option can prevent Clipboard entries from
being lost if ELO closes unexpectedly, for example. If the value 0 is configured, the settings are not
saved until the session is ended.

Display and refresh

Cache refresh interval in seconds: Use this option to set the refresh interval of the Repository work
area. Work areas and settings are updated at this interval.

Limit display in large folders: If you open an entry with the Go to function, only the respective entry
is displayed in the specified folders. This option speeds up the load time, since the other contents
of the specified folders are not loaded. In the Object IDs field, specify the object IDs of the folders
that you want to apply the restriction to.

Storage duration of thumbnails in the cache: The ELO Java Client stores the created thumbnails to
a local cache. In this area, you specify when to delete the cache. Choose from the following
options:

* Delete when closing ELO
* Delete after 30 days
* Never delete

Clear document cache on closing: If this option is enabled, the temporary file folder will be emptied
when you close the ELO Java Client.

Maximum number of documents in the In use work area: In this area, you specify how many
documents can be checked out at the same time. This prevents too many external applications
from being started since this can impact system performance. The default value is 20.

Maximum number of pages in OCR preprocessing: This is where specify the maximum number of
pages per document to evaluate during OCR preprocessing. The default value is 20.

Start search immediately when clicking a search favorite: The Save search and Search favorites
functions on the Search tab enable you to save search favorites and use them repeatedly. Enable
this option to immediately start the search when clicking a search favorite. If this option is
disabled, the search favorite is added without starting the search.

Log file
The log file contains the automatic protocol of all or certain processes of an application.

You can make the following settings for the log file:

Write log file: Select this option to write a log file.
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Open log file: Open the log file for viewing.

Send log file: Attach a log file as a TXT file to an e-mail.
Log file path: Define the storage location for the log file.

Information level: Define how detailed you want the information in the log file to be (default, script
development, debug, or network debug).

Information

You can only make changes to the log file if there is no logger entry in the registry.

Date formats

Possible date and time formats: Expand this list to show the variables for the configuration of the
date and time formats.

Preview: This field shows what the date format would look like with the current settings.

Format for date and time entries: Specify the format for the date and time entries here. The format
used is displayed as an example in the Preview field. The default setting is Use standard Java date
formats.

Please note

If nothing is displayed in the Preview display field, the date entries will not be displayed in
the client either.

Date format: If you have selected the User-defined option, you can choose a predefined date
format in the Date format field or generate your own date format from the variables displayed
under Date and time format options.

Time: If you have selected the User-defined option, you can choose a predefined time format in the
Time field or generate your own time format from the variables displayed under Date and time
format options.

Date format that should also be accepted for entries in ELO: If you have selected the User-defined
option, you can select or create an additional date format that is also valid in ELO in the Date
format that should also be accepted for entries in ELO field.

Replace date in tables with "Yesterday", "Today", and "Tomorrow" as required: Select this option to
replace the date with Yesterday, Today, or Tomorrow as appropriate.

First weekday in the calendar: Use the drop-down menu to set the first day of the calendar week in
ELO. The default value is Monday.

First calendar week: Use the drop-down menu to set when the first calendar week should start.
With the default settings, the first calendar week starts on January 1.
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Number formats

Separator for number entries: Specify the separators used for numbers here. The default setting is
Use standard Java separators.

Thousands separator: If you have selected the User-defined option, you can enter a separator to
mark numbers higher than one thousand in the Thousands separator field.

Decimal separator: If you have selected the User-defined option, you can enter a separator for
numbers with decimal places in the Decimal separator field.

Show or hide work areas

You can hide or show the Intray, Clipboard, Tasks, In use, and Search work areas here.
Folder for document templates

Path: Define in which folder the document templates will be stored in ELO.

OCR (text recognition)

OCR recognition: Specify here whether you want to perform OCR in fast or detailed (but slower)
mode.

Filter: Use this field to filter the Available languages column. The column is updated as soon as you
enter a character.

Reset filters: Deletes the current filter from the Filter field. All available languages are displayed.
Available languages: From this list, select the languages for text recognition that will be used to

analyze the documents in ELO.

Information

The OCR service and languages are only available if an OCR instance has been installed.

Selected languages: In this list, you can see which languages have been selected for text
recognition.

Enable roles

Roles are used to grant users additional rights in ELO. For example, a role can grant a user
membership to the Accounting group. You do not need the additional group rights for your
everyday work, so you can enable them as and when required. You need to enable the role to get
the corresponding rights in the client.
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Active processes

Use this function to open an overview of processes running in the background. This includes, e. g.
import and export processes.

You can view a detailed log for each process. You can save the log as a CSV file (comma separated
values).

You can cancel current processes and select Go to to go straight to the respective entry in the
Repository work area.

You can remove one or all finished processes from the process overview.
Translation table

Available in: Ribbon > Organize > System

Use this function to open the Translation table dialog box. The dialog box lists all terms used in ELO
in a table.

You can enter a translation for each term in the displayed languages. Click the corresponding line.

If you run the client in another language, metadata fields are displayed in the corresponding
language that a translation was entered in the table for.

The basic settings provide columns for the system language (the language selected during the
installation) as well as English (en) and French (fr).

You can add languages via the context menu (right-click in column 'undefined') > Add language.
You can change the language via the context menu (right-click in column with language) > Edit
language.



	Table of contents
	Personalization
	Create tiles
	Create folder view
	Create task view
	Edit and delete tiles

	Customize the ribbon
	Pin/unpin functions
	Show/hide text
	Add/remove favorites
	In the context menu on the ribbon
	In the configuration


	Customize settings
	Configuration
	Search configuration
	Configuration ‒ Display
	General
	Layout options
	Font
	Search
	Lists and tables
	Task list display options
	List of recently used entries

	Configuration ‒ Color scheme
	Color scheme

	Configuration ‒ Dialog boxes
	General
	Version comment
	Notifications
	Annotations when sending as PDF
	Inherit permissions when moving entries
	Drag-and-drop
	Duplicate check
	Load new version
	Check in
	Delete reference
	Multiple entries as link
	Print separator pages
	Delete from the Clipboard
	Delete from the search
	Login dialog box

	Configuration – Metadata
	General
	Show metadata
	Default settings for metadata
	Metadata form for different file types

	Configuration – Document preview
	General
	E-mail
	Preview configuration for different file types
	Preview plug-ins

	Configuration – Quick access to functions
	Quick access to functions
	Assign keyboard shortcuts to function
	Delete keyboard shortcut
	Reset keyboard shortcuts
	Keyboard shortcuts as PDF file
	Add function
	Change order
	Remove function
	Reset functions

	Configuration – Annotations
	Sticky notes
	Marker width
	Horizontal marker
	Freehand marker
	Rectangle marker
	Strikethrough
	Redaction configuration
	Text note configuration

	Configuration – Advanced settings
	General
	Settings for the Intray work area
	Separator page recognition
	Intray folder in the file system
	Workflow
	My ELO
	Signature
	Behavior on double-click

	Configuration – Technical presets
	General
	Display and refresh
	Log file
	Date formats
	Number formats
	Show or hide work areas
	Folder for document templates
	OCR (text recognition)


	Enable roles
	Active processes
	Translation table



